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Copyright

All rights reserved. No part of this documentation may be copied, photocopied,
reproduced, translated, microfilmed, or otherwise duplicated on any medium without
prior written consent of UBS Corporation Sdn. Bhd.

No patent liability is assumed with respect to the use of the information contained
herein. Every precaution has been made to supply complete and accurate information.
However, UBS Corporation Sdn. Bhd. resumes no responsibility for its use, or for any
infringement of patents or others right of third parties which would result.

Disclaimer

No person should rely on the contents of this publication without first obtaining advice
from a qualified professional person. This documentation is provided on the terms and
understanding that (1) the author and editor and copyright owner are not responsible
for the results of any actions taken on the basis of information in this documentation,
nor for any error in or omission from this documentation; and (2) the author and
editor and copyright owner are not engaged in rendering legal, accounting,
professional or other advice services. The author and editor and copyright owner
expressly disclaim all and any liability and responsibility to any person, whether a
purchaser of related software or reader of this documentation or not, in respect of
anything, and of the consequences of anything, done or omitted to be done by any
such person in reliance, whether wholly or partially, upon the whole or any part of the
contents of this documentation.

UBS CORPORATION SDN BHD (441389-K)
Suite 1B-6, Level 6, Block 1B, Plaza Sentral,
Jalan Stesen Sentral 5, 50470 Kuala Lumpur.

Malaysia.
Website: Attp.//www.ubs-software.com

COPYRIGHT © UBS CORPORATION SDN BHD


http://www.ubs-software.com/

EEUBS

User Business System Point Of Sale User Manual Page 3 of 107

Introduction

UBS Point of Sale 2003 system (P.0.S) for windows transform a PC into a powerful point-of
sale cash register for retails sales, services, and rental businesses. UBS P.0.S. system can be
operated with or without bar code equipment.

During the basic transaction, product codes are entered or scanned into the transaction and the
screen instantly displays the quantity, price, and product description. When completed, the
transaction is totaled, sales tax is applied, change is computed, the cash drawer is opened, a receipt
is printed, and inventory and sales records are updated.

Getting Started

First Time Login

After the installation procedure, a shortcut icon is created on the desktop. Double-click the
shortcut icon to open UBS POS or go into Windows Start Menu - Programs - UBS Software ->
UBS Point of Sale 2003.

2 Multi-Company;

Campany Name Folder e

W

| add || Edit || Delete || Select || Ezxit |

* Please take note that this screen is optional. To disable the multi company function, go to
Housekeeping>Setup > General Setup.

Add New Company
A default company name will be given, click the Edit button to update your company name or

Click the Add button to insert another new company.
Different company should keep into different data folder.
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User Business System

Create Database

After select the company name, the system will automatically generate the data files into the
folder you have selected.

** Create Database X

Create Database
Create the databaze for this system. %
F—d

In network environment. make sure you are the only user to access
to this option

Cancel

User Login

When you see the Logon screen, enter the Login ID and Password to access into the system.
The default Login ID = UBS and Password = UBS.

** | ogon X
User ID || |
Password | |

| Lodin | | Cancel |
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System Function
UBS P.0.S 2003 system divided into five functional areas:

1. Maintenance
For a complete Cash Receipt, it contains the information like cashier, salesperson, item(s),
counter, and payment. Before you start entering transaction, you need to have the unique
code for every cashier, salesperson, counter, payment — credit card, and item(s).
At Maintenance, you are required to assign a unique code, description, and other required
information for every cashier, salesperson, supervisor, credit card payment, group, category,
item, cashier counter.

2. Transaction
This is where you enter the transaction for every sale made. Besides, it also contains
information on deposit into and withdrawal from your cash drawer, for you to compare
actual cash amount from your cash drawer.

3. Enquiry

Able to re-print cash receipt and print bar code labels to be placed on items not yet coded.

4. Reports

Able to print important reports, like sales analysis and inventory reports for management use.

5. Housekeeping

This menu contains functions for system setup, system recovery, and backup/restore.
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Chapter 1: MAINTENANCE

GE=g = Transaction Enguiry Reports  Housekeeping Help  Exit

Personnel Files

Member File : |0fsa Ie 2 003

Cuskomer File

Supplier File -
Item Files »
Miscellaneous Files r

The MAINTENANCE is the first menu of the P.0O.S. System. This menu is to establish the
structure of the entire P.0O.S. system. The function ‘maintenance’ here consists of create/add,
modify and delete of Personnel Files, Member Files,

Customer Files, Supplier Files, Item Files and Miscellaneous Files

1.1. Personnel Files

Personnel Files maintenance is to main the full information of the Cashier, Supervisor,
Salesperson/Agent and Promoter.

Rl e= Transacktion Enguiry Reports Housekeeping Help  Exik

Personnel Files L Cashier

Membert File » Supervisor
Cuskomer File 4 Salesperson | Agent
Supplier File k Prarmioker

Item Files k

Miscellaneous Files k

The Personnel Files maintenance drop down menu allows you to create the particular of: -
1. Cashier
2. Supervisor
3. Salesperson/Agent
4. Promoter

1.1.1. Cashier

In Cashier maintenance, you have to assign Cashier ID., Name and password. You may
simply move the cursor to the selected field and add or modify information as necessary.
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** Cashier

]

Cashier | Listing

Cashier ID cool

Tarne CASHIER 001 |

[oes | et || oo |[ seorsh | [ e |
Cashier ID. - Assign an ID for your Cashier.
Name - Key in the Cashier Name.
Password - Key in the Password for Cashier.

Supervisor

Supervisor is the person who has the rights to make certain changes when encounter
problem by the cashier.

Examples, when Cashier wrongly key in amount or item they are unable to correct the
problem so they need the Supervisor to correct.

Under Supervisor Maintenance, assign a Supervisor ID (maximum 8 characters), Name
(30 characters) and password (8 characters) for every Supervisor and click on save
button.

% Supervisor r5_(|

Supervisor | Lisking

Supetvisar 1ID s001

Mame SUPERVIZOR 00L |

Password FEEEEETE

I add H Edit ” Delete ” Search ] ’ Exit ]
Supervisor ID. - Assign an ID for your Supervisor.
Name - Key in the Supervisor Name.
Password - Key in the Password for Supervisor.
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Salesperson/Agent

In Salesperson/Agent maintenance, you have to assign Salesperson / Agent ID and
Name.

** Salesperson f Agent E|
Agent |Listing
Agent ACOOL
Marne AGENT 001 |
[aad [ e | ooete |[ semeh | [ ent |
Agent - Assign an ID for Salesperson/Agent.
Name - Key in the Supervisor Name.
Promoter

Promoter is the person who stands near the item to promote new offers and their usage.
By assigning code (maximum 8 characters) and their name (maximum 30 characters) for
every Promoter, the management will be able to check the item and quantity sold by the
person.

** Promoter [z|
{| Listing
Pramater FOO1
Mame PROMOTER 001 |
[ Add “ Edit “ Delete ” Search ] ’ Exit ]
Promoter - Assign a code for Promoter.
Name - Key in the Promoter Name.

COPYRIGHT © UBS CORPORATION SDN BHD



EEUBS

User Business System

1.2. Member File

Point Of Sale User Manual

Page 11 of 107

Member File maintenance is to maintain the full information of the Member, Membership Class,
Occupation, City, State, Country and print the Member List.

Maintenance

Personnel Files

Mermber File

Transaction Enqguiry Reports

vl

Cuskomer File

Supplier File

Item Files

Miscelaneous Files »

1.2.1. Member

Mernber
Membership Class
Occupation

City

Skate

Caunkry

Print Member Lisk

Housekeeping Help  Exik

Assign code for every member; maintain both the general (e.g. address, gender and etc.)
and the details (e.g. occupation, membership class and etc.) information for each

member.
=* Member El
Membership Mo, Mool |
Mame STANLEY CHONG
| Detail || Listing
Address 10, LORONG DELTMA 1,
TAMLN DELIHMA,
GLUGOER
Ciky GEORGETOWH
Skate PENANG
Country MALAYSTA
Telephone 04-A561122 Gender Male
Handphone 012-55125453 Race Chinese
MRIC Mo, T40606-07-4521 |
Crate of Birth 06/06/1974
[ Add H Edit ” Delete ” Search H Print ] ’ Exit l

Membership No.

Name

- Key in the Members name.

- Assign a Membership Number for every new member
(maximum 20 characters).

Under Membership maintenance, there are 2 pages where you have to key in member’s
particulars and one page is the member listing.
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i. General

i| Detail || Listing

Address 10, LORONG DELIMA 1,
TAMAN DELIMA,

GLUGOR
Ciky GEORGETOTN
State PENANG
Country MALAYETA
Telephone 04-6561122 Gender | Male
Handphone 0l2-55125453 Race Chinese
MRIC Mo, T40606-07-4521
Diate of Birth 06/06/19374

Key in the member’s particulars like Address, Telephone, Hand Phone,
NRIC, Date of Birth, Gender and Race.

i, Detail
General Listing
Occupation MANAGER.

Membership Class | GOLD CLASS
Regiskration Date 0l/10/z2002
Expired Date 01/10/2003

Point &vailable 0

Comment s

Key in the member’s details like occupation, membership class, registration date expired
date and point available.

Membership Class - Allow specifying the type of membership class.

Point Available - Points that claimed by the member throughout the purchase.

iii. Listing

General || Detail

embership ID Mame -~

Moonz ERIC

Display all the Membership ID and Name in list. Click on the Membership
ID or Name to see the member details.
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1.2.2. Membership Class

Some company issuing membership for their customer. Membership Class is to classify
the member type and discount can be given.

** Membership Class

Class ‘Listing

Class Ccool

Description SILVEE CLASS

Itemised Discounk 10.00%

surnmaty Discount 10.00%

[ ........ .ﬁ.u:lu:l ......... ” Edit ” Delete ” Seatch ] ’ Exit ]

Class - Assign a code for the Membership Class.
Description - Key in the Membership Class Name.
Itemized Discount - Discount given for individually item purchase.
Summary Discount - Total Summary Discount for the item(s) purchase.

1.2.3. Occupation

This option enables you to maintain an occupation list for use in Member Maintenance.

** Occupation [‘5—<|

Occupation | Listing

Occupation MGE

Drescription MANAGER. |

add H Edit " Delete " Search ] [ Exit ]

Occupation - Assign an Occupation Code.

Description - Key in the Occupation Description.

1.2.4. City

This option enables you to maintain the City list for use in Member Maintenance.
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* City X

City IListingl

City 5P

Mame SUNGAT PETANI |

[as | e || ooete || seasr | [ car |

City - Assign a City Code.
Name - Key in City Name.

1.2.5. State

This option enables you to maintain State list for use in Member Maintenance.

* State D_(l

State |m|
State P
Tarme PEHANG |
[ ........ ﬂdd" Edit “ Delete ” Search ] l Exit l
State - Assign a State Code.
Name - Key in the State Name.

1.2.6. Country

This option enables you to maintain Country list for use in Member Maintenance.

= Country r>__<|
i« | Listing |

Counkry k'

Mame MALATSTL |

(ot | e )| ookte [ semmn | [ owt ]
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Country - Assign an Occupation Code.
Name - Key in the Occupation Description.

1.2.7. Print Member List

It will list the entire Member List base on the criteria you specify.

** Membern List E'
Member Range
Mermnber Fromm E]
Mermber ko ZEZEZEZEEEEEEEZEEEREE E]
Sork By |I-Iemhership Ho. bl |
View | Typical vl|

| (5] 4 | | Cancel |
Member From/To - Select the member number from the list down arrow for

viewing by range.
Sort By - Select the report to be sorted by Membership No. or Name.

View - Select to print out the typical or details report.

1.3. Customer File

Customer File Maintenance consists of Customer File Maintenance and Customer List.

IHM Transackion Enquiry FReports Housekeeping Help  Exik

Personnel Files »

Mernber File b nFemla o n 3
Cuskomer File L Cuskomer

Supplier File » Print Cuskaormer Lisk

Item Files »

Miscellaneous Files »

1.3.1. Customer

Assign code for every customer maintain both the general (e.g. address, gender and etc.)
and details (e.g. credit limit, balance and etc.) information for each customer.

If the system links with stock control the below information will appear automatically.
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** Customer, E|
Customer Mo, 3000/A01
Mame ASTE UBS CONISULTANTS LTD Date 09/05/2003

|EH Listing |

Invoice To Deliver To

ROOM 513, WORKINGEOND COMMERCIAL ROOM 815, WORKINGEOND COMMERCIAL

CENTEE, 162-164 PRINCE EDWARD CENTEE, 162-164 PRINCE EDWARD

ROAD WEST, EOULOON HLSAR. ROAD WEST, EOWLOON HL3AR.

HONG EONG HONG KEONG

Attention ME. EDWARD CHAN Atkention ME. EDWiRD» CHAaN

Phone #1 §52-59321000 Conkack MF.. EDWARD» CHAN

Phone #2 #52-89321002 Mature of Business FESELLER

Fax §52-89521005 Status

[ Add ” Edit “ Delete ” Search ” Print I l Exit ]

Status - Set the status to Bad to disable further purchase by this

customer.

* Preferably to follow the UBS standard coding for debtors, e.g. 3000/000
Customer File Maintenance consists of 2 pages.

i. General

il Detai |J Listing |

Imvoice To

Deliver To

ROOM 13, WOREINGEOND COMMERCIAL

ROOM 13, WOREINGEOND COMMERCIAL

CENTRE, laZ-164 FRINCE EDWARD

CENTEE, la2-164 FRINCE EDWARD

ROAD WEST, EKOWLOON HLSAR.

ROAD WEST, EOWLOON HLSAR.

HONG EONG HONG EONG

Attention ME. EDWARD CHAN Attention ME. EDWARD CHAN
Fhone #1 #52-89321000 Contack ME. EDWARD CHAN
Phane #2 852-89321002 Mature of Business | RESELLER

Fax #52-89321005 Status

Assign Invoice To and Delivery to address, name of attention, contact
number, contact person and nature of business.

. Detail

General Listing |

area |HDI-IG KONG |
Agent AGENT 001 |
Terms

Credit Limit 5,000.00

Target 10,000,00

Foreign Currency TS DOLOE

Email Address edchanfhotnail, com

Website www. ub3-asia. con
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Allow you to key in more information regarding the customer.

Area

Agent

Term

Credit Limit
Target

Foreign Currency

iii. Listing

General || Detail

KCustamer Ma, Mame

Point Of Sale User Manual

- Select region boundary for the individual client.

- Select agent for the individual client.
- Key in the term given to the client.
- Value set for the upper limit on client’s account.

- Target set for the client’s purchase.

Page 17 of 107

- States the currency type of individual client used for
transaction.

Phore #1

.

Display all the Customer record in the list. Click on the record itself to see the details.

Print Customer List

It will list the entire Customers/Debtors base on the criteria you specify.

** Print Customer

customner From | [

Customer ta ZEEE/EZEE

Customer Range

)
i

Sork By Customer No.

Salesperson / Agent

W

agent from B

Agent to EEEEEELEEEEE B

Area w

Wigw Typical b
oK l [ Cancel
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Customer From/To - Select the customer number from the list down

Sort By

Agent From/To

Area
View

1.4. Supplier File

arrow for viewing by range.

- Select the report to be sorted by Customer No. or Name.

- List only those customers from this agent.

- Only those customers in this area. Leave blank for all areas.
- Select to print out the typical or details report.

Supplier Maintenance consists of Supplier File Maintenance and Supplier List.

WEEER=N Transackion Enguiry  Reporks

Personnel Files
Member File

Cuskomer File

Suppliet File

Item Files

Miscellaneous Files

4
2
4
2

Supplier

Print Supplier Lisk

Housekeeping  Help

|of sale2003

l

1.4.1. Supplier

Exit

Assign code for every Supplier, maintain the General (e.g. address and Attention) and
under Detail (e.g. Term, Credit limit and etc.).

“* Supplier

Supplier Ma.

Marme

Invoice To

| Detail || Listing

4000401

X

ACCENT COMMUNICATIONS 5DN EHD

Date 10/05/2003

158-3, LORONG EC/91,

TAMAN SHAMELIN PERKASA,

CHERAS 56100 EUALA LUMFPUR

Atkention ME F0H Contact COLIN CHOW
Phone #1 603-95445993 Mature of Business TECHNOLOGY
Phone #2 0l2-3564521 Status
Fax 603-95445994
[ Add H Edit " Delete " Search " Print l l Exit l
Status - Indicating the black listing Supplier.

Supplier File Maintenance consists of three (3) pages.
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i. General

Deetail || Listing

Invoice To 15-3, LOROHNG 6C/91,
TAIMAN SHAMELIN PERKASL,
CHERAS 56100 KUALA LUMPUR

Attention MR GOH Conkack COLIN CHOW
Phone #1 603-954458993 Mature of Business TECHNOLOGY
Phone #2 0l12-3564521 Skatus

Fax 603-954453994

Allow you to state the address, contact information and nature of business for supplier.

ii. Detail

General | Detall | |isting

Area FUAL4 LUMPUR
Agent AGENT 001
Terms

Credit Limit

Target
Foreign Currency

Email Address

Website
Area - Select region boundary for the individual vendor.
Agent - Select agent for the individual vendor.
Credit Limit - Value set for the upper limit on vendor’s account.
Target - Target set for the vendor.
Term - Credit term given from the vendor.

Email Address - Key in the email address.
Web Site Address - Key in the home page address.
Currency - Key in the currency code and symbol.

* There must be entry at the Currency Maintenance first.

iiii. Listing
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General || Detail ||

Eupplier Ma. Mame Phone #1 ~

Display all the Supplier record in the list. Click on the record itself to see the details.

Print Supplier List

It is same as Creditors Listing on UBS Accounting / Stock Control software, then will list
the entire Supplier / Creditors base on the criteria you specify.

** Print Supplier E|
Supplier from h E]
Supplier ko N B
Sark By Supplier No. bt
Agent From B
Agent ko ZEEZEZZEEEZER E]
Area W
Wig Typical h
I """""" o l ’ Cancel I
Supplier From/To - Select the supplier number from the list down arrow for

viewing by range purpose. If you leave blank then the system
will list your entire supplier.

Sort By - Select the report to be sorted by Supplier No. or Name.
Agent From/To - This option indicating which agent.
Area - You also can print or view by area by selecting the specify area
name.
View - Select to print out the typical or details report.
Item Files

Item Files Maintenance consists of Item Maintenance, Category, Group, Item, Service Item, Item
Location, Item Serial No., Edit Item and Grade Opening Quantity and promotional item.
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GEGIGCEae=N Tranzaction Enguiny  Reports  Housekeeping Help  Esit

Perzonnel Files k
' of sale 2003
Custorner File *
Supplier File * e
Item Files Category
GErou
Mizcelansous Filez ¥ P
[tem
Service lkem
Item Location
Item Senal Ma.
Item Opening Quantity
Grade Opening Quantity
Promational [bem
Category

Page 21 of 107

Enables you to classify various type of stock into the correct classification and it will be

similar to stock category.

** Category E|
Category | Lisking
Category j510)
Descripkion S0FTARE
[ ........ Fl.u:lu:l ......... H Edit “ Delete “ Search ” Print ] ’ Exit ]

Click Add button and assign a category code, follow by its description.

e.g. Category Description
HW HARDWARE
SW SOFTWARE

Click Save button to save the category code.
Click Delete button to delete unwanted category code.

Click Print button to print category code.

Group

Enable you to define each category into group details and the item grade.
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. [Group 3]
‘ Grade || Listing
(roup GRPOL
Description GROUP 1 |
’ Add “ Edit “ Delete “ Search ” Print ] ’ Exit ]

Click Add button and assign a Group code, follow by its description.

e.g. Group Description
HWP PRINTER
HWS SCANNER

Ma, Grade Description I
| Z|M Fize
| 3L 3ize
| 4|KL Fize
| 5
n g
| 7
| g
q L
’ Add “ Edit ” Delete ” Search “ Prink l’ Exit l

Key in the Grade Description for this specify group.
Click Save button to save the group code.
Click Delete button to delete unwanted group code.

Click Print button to print group code.

1.5.3. Item

It is same as Item File Maintenance in UBS Stock Control System (if you link), it will
allow you to manage the database of Item file.
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Item Mo, A0000L
Drescription ARC LASER PRINTER
General | pmulkiple Unit || Listing
Alternate Item Mo, Brand AEC
Cateqory HIW Shelf Mo. Minimum Qty
Group HWE Packing Fearder Gty
Supplier Cost Code Quankity B 10
ik OF Measure 3ET Paint 500
Unit Cast 750.00 Promater FROMOTER 001
Price - & a00. 00 Tax Percentage #1
Price - B 9z0.00 Tax Percentage #2
Price - C 950.00 Expired Date Y
l First ” Previous ” Mext ” Last ] [ Add ” Edit ” Delete ” Search ” Print ] l Exit I

Item File Maintenance consists of three (3) pages i.e. General, Multiple Unit and Listing.

* To modify, click on the Search button or go to Listing Page to select the item you want
to modify, then click on Save button to save the changes.

Item No.

Description

i. General
Alternate Item No.

Category

Group

Supplier

Unit of Measure

Unit Code

Price-A/B/C

Shelf No.

- A code or number assign to the item.

- Explanation of the item.

- Assign another item number only if necessary.

- The classification of product for this item e.g. raw material and
finish goods. You may search for the code by clicking the arrow
down key.

- The group of which this item belong to e.g. computer,
software and accessory. You may search for the code by clicking
the arrow down key.

- If there is only one main supplier supplying this item, you may
keep a record of the supplier. Otherwise, leave this column
blank.

- The unit of measurement for this item, whether it is measured
in pieces, length, weights and etc.

- The cost of an item. This cost price will remain the same
unless you request the system to update the new cost price
when you receive stock at transaction receive.

- There are three (3) pricing levels, which can be set for an item.
It is useful to users who sell at different price to different
customer.

- The shelf nhumber is used to identify the specific place / rack of
an item in the storeroom or warehouse.
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Cost Code
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Promoter

Tax percentage #1
Tax percentage #2
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- The packing of the item and usually it is measured in weight.

E.g. Unit of measure = 1 tin
Packing = 250g

- Enter the item cost code.

- This keep the point value allotted to this item. Some
companies adopt the ‘point value system’ in their marketing
policy, where every product carries a certain point value. This
point value will be used for cash rebate, exchanging of gift, cash
voucher and etc.

- The person who has arranged to promote the item.

- You can indicate the percentage (%) of your tax.

Expired Date - Indicate the item’s expired date.

Brand

Minimum Qty

Reorder Qty

Quantity B/F

Contain Serial No.

Contain Grade

i, Multiple Unit

General | Multiple Unit
Lnik

DOZEN

Unit

- Indicate the item’s brand name.

- If stock level goes below this quantity, the stock item will be
printed out in Reorder advice.

- If stock level goes below the minimum level, the reorder
advice will advise you to order this quantity.

- The item’s opening quantity. This is the quantity at the
beginning of the year.

- If the items come with serial No., select this option by ticking
this check box. The system will prompt the item serial number
during transaction.

- If the items come with Grade, select this option by ticking this
check box. The system will prompt the item grade during
transaction.

Lisking
Factor #1 Fackor #2 Price
12,0000 1.0000 9,.000.00

- An alternative unit of measurement. E.g.

uoMm Unit
Pieces Dozen
Box Carton
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Factor # 1 & 2 - If you have multiple unit for your item, then you have to

indicate the unit factor. This is the conversion ratio between 1%
Unit and 2™ Unit. E.g.

1% Unit 2" Unit Factor # 1  Factor # 2
Pieces Dozen 12.00 1.00
Box Carton 10.00 1.00
Price - The unit price for the 2™ Unit of Measurement.
iii. Listing
General || Mulkiple Unit |—
Lberm Mo, Descripkion Group i
M
343434 CABLE GRF
400001 ABC LASER PRINTER HWP
ddds DIIST COVER GEF

Display all the Item record in the list. Click on the record itself to see the details.

1.5.4. Service Item

Enable you to create a service code for a task performed or service rendered.

** Service ltem g|
Service Item | [isting
Service Ikem SVE-0001
Descripkion RO0OM SERVICE
Account Mo.
Credit Sales 0000000
Cash Sales 0000000
Sales Return 50107000
Purchase 0ooos000
Purchase Return A010A000
add ” Edit " Delete " Search " Print ] ’ Exit ]

Click Add button and assign a service code. Then specified account nhumbers for this
service, i.e. Credit Sales, Cash Sales, Sales Return, Purchase and Purchase Return.
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1.5.5. Item Location

Enable you to create a location code for specifying the exact place of the goods being
stored.

Click on add button and assign a location code, follows by its description and address.

** |tem Location

‘ Listing
Location TARE
Description TWAREHOUSE
Address LOT 123, BAVAN LEPAS IND. ESTATE,

MPFPF WAREHOUSE

PENANG

’ fdd ” Edit ” Delete “ Search “ Print l’ Exit ]

1.5.6. Item Serial No.

Enable you to maintain item serial number with expiry date.

** |tem Serial No. ®
lkem Mo, Drescription Group |
B W
| Edit | ’ Refrash l [ Close ]

Click on the Edit button to maintain the item serial number.
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% |tem Sernial No - ADDOOT

Eerial Mo, Skatus Date (Im) Doabe {C0t) Expired -
_|0zlolol Availahle 07/03/2003 01/01/2005
B w
Setial Mo, 0z101l00 | [ Cirew H & edit ” EZ Delete ]
Expired Date 0l/0Ll/2005
Status available | Type |
Dake {In) 07/03 /2003 Reference Mo,
Doabke {C0t) F

[ QK ] [ Cancel ]

Click on the New button to insert the Item Serial No. together with their expired date,
status, date in and out.

* In order to ypdate the Item serial number, you have to click on the Contain Serial No.
check box in Item Maintenance.

Conkain Serial Mo,

1.5.7. Item Opening Quantity

Not all users starting with zero balance of stock, this section allows you to show all items
opening quantity and cost.

** |tem Opening Quantity

[tern Mo, Inik Init Cost Quanticy BIF Las
343434 PCE 0.00 100,00
400001 SET 750,00 10,00
EBALNNEER. TUNIT 15.00 0.00
EARCODE TNIT 26,000,.00 0.00
CALENDAR PC3 0.z0 0.00
ddds UNIT 0.00 0.00
v
Ikem Ma, 12312
Descripkion EANNER
Unit Cost 1.00
Quankity BfF 3,000.00 | PC3
[ Edit I I Exi

COPYRIGHT © UBS CORPORATION SDN BHD



EEUBS

User Business System Point Of Sale User Manual Page 28 of 107

1.5.8. Grade Opening Quantity

You are able to maintain the grade opening quantity in this option.

* Grade Dpening Quantity 3]

| Liskirg

Item Ma. CCE ELUE SHIET |

Descripkion CCE ELUE T-SHIRT |
Group SHIRT Quantity BfF

Mo,  Grade Descripkion Cuiankity ~
» |
M Bieze
L 3ize
XL Fize
L Bize

L B S S I o
= s s s

e

l Edit ” Search ]’ Exit ]

* In order to update the Item Grade quantity, you have to click on the Contain Grade.
check box in Item Maintenance.

Contain Grade

1.5.9. Promotional Item

For giving discount on individual promotional item, use this option to enter item one by
one. You are also able to update the promotional item under Batch Update.

** Promotional ltem E|

Ikem Mo, A00OOL |

Description ABC LASEE PRINTER |

Date from 0Ll/05/2003 Categary Hil

Date to 01/06/72003 Group HWE

Offered Type | Digcount Consumer All

Discounk % | 20% 0%
[ List Item ” Batch Update I

l First H Prexvious " Mexk H Last I l Edit H Search ] l Exit ]
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Indicate the promotional period, the discount % or price, point and state whether this is
only apply to member only.

* In order to activate the promotional item function, you have to go to Housekeeping >

Setup > Transaction Setup, Function = Item Function Activation to tick on the
Promotional check box.

Batch Update

=% Batch Update (%]
Update | Delete

Zateqory from E]
Cateqory to 4:4:4:44:4:4 4 E]
Garoup From E]
Group bo ZEEZEZEEE E]

Ttem Mo, From

)
i

Item Mo, to ZEZEEECEEECEEEEEEEELEREE
Date from 01/056/2003 Consumer All bl
Date ko 31/05/2003
Offered Type |Discount e
Discount % 20% 0%
Discount 0.00

(e ][ el ]

Group, Category and Item number use for filtering.

Group From and To - Enter the promotion by group.

Category From and To - Enter the promotion by category.

Item No. From and To - Enter the promotion by item number.

Date From and To - Indicating the promotion period.

Offered Type - Indicating the offer type whether the promotion is
discount by percentage, by price or giving point.

Consumer - Select the promotion is apply to all customer or
member only.

Discount - If there is any discount, then key in the percentage (%)

or discount value.
Price - Indicate the item price during the promotional period.

Point - Indicate the point given for the item.
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Miscellaneous files consist of Credit Card Maintenance, Voucher Maintenance, Counter
Maintenance, Area Maintenance, Project Maintenance, Foreign Currency Maintenance and

Reason Maintenance.

GEIEREREEN Transaction  Enquiy  Reports

Personnel Files

tember Filz

Customer File

Supplier File

[tem Files

llahizous Files

1.6.1. Credit Card

Credit Card

Special Dizcount

Counter
Table
Area
Project

Foreign Currency

Reazon

Houzekesping Help  Exit

' of sale 2003

Assign code for different type of credit card and maintain the percentage (%) to charge
on total sales if payment made by credit card.

** Credit Card

Credit Card
Description
Type

Account Ma,

Credit Card | |jsting

Service Charge Computation

VIS4 CREDIT CARD

#1 - Amount Between 50.00 | Charge .00%
#2 - dmount Between 9,999,993, 99 | Charge L 00%
[&dd_" Edit ” Delete " Search l l Exit l
Credit Card - Assign a code for the credit card.
Description - Then key in the description on the above code.
Type - Select the Credit Card Type.

Account No.

- Specify the Account No for this credit card.
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Service Charge - If the amount exceeded certain limit, then key in the
limit and the percentage to be charged.

Customer pays for the - If you tick this check box, the service charge
Service charge will be paid by customer.

Always enter credit card - The system require to key in the credit card
number number during the payment.

Always enter expired date - The system require to key in the credit
card’s expired date during the payment.

1.6.2. Special Discount

This discount is calculating base on the total amount on the receipt (after item discount,
before tax).

*%* 5 pecial Discount

Discount | Listing
Discount Code Yool
Description HEW YEAR PROMOTION
Discaunt Percent 30%
Diiscaunk 0.00
Walid From 0l/01/2003
Yalid To 01/02/2003
[ﬂddu Edit “ Delete Search ] [ Exit ]

* In order to activate the Special Discount function, you have to go to Housekeeping 2>
Setup > Transaction Setup, Payment to tick on the Special Discount check box.

1.6.3. Counter

Each counter should assign a code/name to certify the group of transactions.

** Counter El
| Lisking

Counker CTE1

Description COUNTEE 1 |

R
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1.6.4. Table

If your nature of business is restaurant, you might require to record down the table no.
you have in your restaurant.

~* Tiable ]

| Listing

Table 0l

Description TAELE 1 |

(o | e [ oote [ oo | [ o2t ]

* In order to activate the Table function, you have to go to Housekeeping > Setup 2>
Transaction Setup, Functions = Entry Activation to tick on the Table check box. The
system will prompt to key in the Table no. during the transaction.

1.6.5. Area

Enable you to create an area code for specifying the position of a geographical region
and it will be similarly to stock control system.

== firea El

Area | Listing

frea HE

Description HONG EONG |

[ Edit “ Delete " Search l ’ Exit ]

1.6.6. Project

Link from Stock Control System and it enables you to maintain project titles.

** Project &|

Project | Listing

Project ACC

Descripkion ACCOUNTING |

| add " Edit ” Delete H Search I ’ Exit I
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1.6.7. Foreign Currency

Enable you to maintain multi currencies, which is required for companies engaging in
foreign trades.

** Foreign Currency b__<|

Currency | Listing

Currency Code UsD

Currency \Word 75 DOLOR |

Currency Symbal Tas

Rate | 3.50000

| add | Edt | olere | [ Ea |

* Recommended to set the Currency Code according to the international standard.

1.6.8. Reason

Enable you to maintain the reason to use while there is a receipt voided.

% Beason [
Reasan o1
Description ITEM EROKEN |
’ Add “ Edit " Delete ” Search ] ’ Exit l
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Cash Receipt
Receipt Fecording

2003

Cash Recording
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The TRANSACTION is the second menu of P.0.S. system, information on Cash or Credit cards
have entered in this menu. Transaction pull down menu consists of Cash Receipt, Receipt

Recording, Cash Recording, Voucher Recording and Inventory Transaction.

Cash Receipt

Before cashier started their daily routine works, Cashier Sign in dialog box is required for

personnel certifying and records tracking.

** Cashier Sign In

% Counter COUNTER 1 b
Cashier Mo, CASHIER 001 M
Password

l oK ] l Cancel ]

Once you have entered the correct password from the login screen, you will proceed into this
screen to enter sales detail like item purchase, quantity, price, and discount.

Press arrow down key select the item or scan the barcode. The system will search the item and

pop out the default-selling price and discount and calculation the amount.

** LCazh Receipt - 001. CASHIER D01

a]=] 3]

-

F3 Cash F& rultiple Payment F& Other
4 oot P oo £ o e RM 761.00
Item Mo, Description Quankity Price Discaunt Armnounk
1 BANNER. EBANNEFR. 1 UNIT 8.00 0.00 g.00
2 A4-P-CASE 44 PAPER CASE 1 SET 3.00 0.00 3.00
Itern Mo, E]
Description
Quankity [n] “
Price o.oo
Discount 0% 0% o.o00
Amount 0.00
ﬁ Cashier : 001, CASHIER 001 Accept Other

To hide or display the full entry columns, press F9 Fast Key.
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While you hide the entry columns, you only need to scan the barcode or manual type in the item

code without changing quantity, selling price and discount. Please take note that this feature
could only allow one (1) unit of item.

Item Mo. || |B

Ikem Mo, |B
Description

Ciuankity Q.00 | b |
Price 0.o0

Discount 0.00% || 0.00% " 0.00 |
Arnounk 0.0o

You are allowed to alter the description, quantity, price and discount price column, if you select
the option at Housekeeping - Setup - Transaction Setting and Appearance > Item Appearance.

Cash Payment- Press F3

Tatal Jel.00
Paid

[ o ][ coen ][ sy ]

Credit Payment -Press F4

8 Credit Card Payment $#1 =
Credit Card Type | MaSTER CREDIT CARD hd |

Card Mo, |

Expired Date i

Approval Code

[ o J[ con [ sy ]

Multiple Payment - Press F6
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A% Multiple Payment )]
Grand Total 761.00
Balance Remained 0.00
Credit Card #1
Credit Card #2 0.00
Cheque 0.00
Voucher 0.00
Deposit 0.00
Cash 0.00
’ o] 4 ] ’ Cancel ] l Summary l

Cancel - Press F7

\_?() Are you sure you want bo cancel the rangachion’?

Other - Press F8

| O Hold |

Save Order

Prink Receipk

Cancel
Header
Go Back,
On Hold - Hold the Order.
Save Order - Save as Sales Order.
Edit Order - Edit the on hold Order or Sales Order.
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Print Receipt -

Cancel

Header

Go Back

Sign Out

Receipt Recording

** Receipt Recording

Reprint the Receipt.
Cancel the transaction.

Pop up the header screen.

Return to the Cash Receipt entry screen.

Exit the Cash Receipt entry screen.

Date Fram 0170142003 00:00
Date ko 1470542003 00:00
F.eference Mo, Date Cashier Grand Total Moid e
M
w
Reference Mo, C& o0ooz " 05/05/20035 14:01
YWoid Status Unwoid |
Superwvisar |
’ Edit ] l Exit ]

To cancel/recover receipts based on the Reference Number given. You can filter out the receipts
by the date issued and select the receipts no you want to void or recover and click on the Edit
button. Select the Supervisor who performs the task.
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Cash Recording

X

** Cash Recording

Cash Recording | Listing
Reference Mo. CIND0O0L
Date 05/05/2003 14:05

Counter COUNTERE 1

In the presence of
Zashier CASHIEER 001
Supervisar SUPERVISOR 001

Passward

INE-E Type of Transackion Opening Drawer

Zash Amount 1500.00

Remark.

[ Add |l Edit ” Delete " Search H Brint l l Exit l

Cash Recording is designed for opening and closing cashier’s drawer, it is also allows adjustment
on cash so that the cashier can carry on duty smoothly.

Opening Drawer and Cash In is the money bring in by the cashier before start using the cash
drawer. Click on the Add button to create a new transaction.

Cash Out is the money the cashier withdraws before she/he changing shifts or finish work.

By referring to the reference number, amount of cash can be modified for that particular
transaction. This feather is control by the supervisor password.

To edit the transaction amount, search for the reference no. and update the fields you want to
edit.

Inventory Transaction

Inventory Transaction consists of nine (9) options. There are: -
Receive, Purchase Return, Delivery Order, Invoice, Cash Sales, Credit Note, Issue, Adjustment —
Increase and Adjustment - Reduce.

Maintenance !m Enquiy  Heports  Housekeeping Help  Exit
Cash Receipt
Receipt Recarding
22003
Cazh Recording

m Inventory Trangaction Receive

Purchaze Retun

Deelivery Order
Irwoice
CashSale
Credit Mate

lzsue
Adjustment - Increase

Adjustment - Reduce
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2.4.1. Receive

Stock Receive enables you to check the stock received. The stock quantities will update
automatically if your P.0.S. system linked with UBS Stock Control system.

Header
** Beceive - BC 00001
Header | Dietail ” Surnmary ” Listing |
Reference Mo, RC 00001
Date 23/05/2003 16:34|  Period
Descripkion PURCHASES
Yendor Mo, [ 1000/000 |~ [suppLiER 1 | term | |
Agent | acEwT 1
Purchase Order Mo, PO-030231 Delivered By l:l
Delivery Order Mo, RE-309442
Coadd | Ede " Delste " Search " Print ] [ Exit l
Detail

** Receive - RC 000071

Header | Summary ” Lisking |
Item No. |
Description
Quantity 1] |
Price 0.00
Discount 0% 0% 0.00
Tax 0.00% 0.00% 0.o0
Amounkt 0.00
Ikem Mo, Descripkion Cuankity Price Discounk Arnount [
1 44-P-CASE 44 PAPER CASE 1 5ET 2.00 0.00 2.00
Z BARCODE AMAND MTx-10 BARCODE READE 1PC3 Z,500.00 4% Z,400.00
v
Total Amount Z,40Z.00
I Add " Edit " Delete " Search " Print ] I Exit ]
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Summary

** Beceive - RC 000071

Header | Detail isking

Total Z,402.00
Discount | 10% " 0% " 0% | 240, 20
Mett Z,161.80
Tax | 5.00% " 0. 00% " 0.00% | 105.09

Grand Total 2,269.89

I Add " Edit " Delete " Search " Print ] I Exit ]

2.4.2. Purchase Return

Purchase Return enables you to view and print the Purchase Return information.

Header

** Purchase RHeturn - ER 00001

etail || Summary || Listing

Reference Mo, PR 00001
Date 23/05/2003 16:33 Periad

Descripkion PMIRCHASES FETURN

vendor ha. [ 1000,000 |~ |svrpLiER 1 | tem | |

Agent | AGENT 1

Purchase Order Mo, PO-453049 Delivered By I:I

Delivery Order No, RE-349090

[ Add “ Edit " Delete " Search ” Prink ] [ Exit ]
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Header | Surnmaty ” Listing |
Item Ma, CANPRIN-2304 |
Description CANON PRINTER
Quantity 1 | UNIT |
Price 530.00
Discount 0% 0% 0.00
Tax 0.00% 0.00% 0.00
Arnount 530.00
Ttern Mo, Description Quantity Price Discount Amnount )
M
s
Total Armount 530.00
I Add " Edit " Delete " Search " Prink ] I Exit ]
Summary

** Purchase Heturn - ER 00001

Header ”m i I Listing |

Total 530.00
Discount | 20% " 0% " 0% | 106,00
Metk 424,00
Tax | s.o0s| o.00s] o.00%] 21.20
Grand Total

I Add " Edit “ Delete " Search " Print ] I Exit ]
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2.4.3. Delivery Order

Delivery Order enables you to enter the list of items or products delivered to customer.

Header

** Delivery Order - DO 00001

sIDetaiI |J |J Listing |

Reference Mo, D0 00001
Date 13/05/2003 15:47 Period

Descripkion DELIVERY
Customer No. | 20004000 ‘ | CUSTOMER: 1 | Term |
Agenk |AGENT 1

Purchase Order No.

Delivery Order Mo,

[ add " Edit " Delete " Search “ Brint ] [ Exit ]

Detail

** Delivery Order, - DO 00001

Header || Detail | H Listing |
Item Ma, 44-P-CASE |
Descripkion 44 PAPER CASE
Quantity 10.00 ” |

Ikem Mo, Description Cuankity L]

Z BARCODE AMANO MTx-10 BARCODE READER 1.00 PC3
v
(oo I ea J oo Jomwr | o ) [ ]
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2.4.4. Invoice

Invoice enables you to enter a list of goods sold to customers on credit with price
changes.

Header

= [nyoice - INV00001 FEX

g” Summary H Lisking |

Reference Mo, INVOD0OOL
Date 19/05/2003 10:11 Periad

Descripkion SALES
Customer No. | 2000/000 |+ | cusTomER 1 | tem |
Agent |

Purchase Order No.

Delivery Order Mo,

I Add " Edit " Delete " Search " Print ] I Exit ]

Detail

** [nvoice - INVOO001

Header | Summary ” Lisking |
Item Ma, 44-P-CASE |
Description 44 PAPER CASE
Quantity 1.00 |
Price 3.00
Discount 0.00% 0.00% 0.00
Tax 0.00% 0.00% 0.o0
Arnount 3.00
Ikem Mo, Descripkion Cuankity | Price Discounk Arnount L]
M
v
Total Amount 3.00
I Add " Edit " Delete " Search " Print ] I Exit ]
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Summary

** |nyoice - INVOOOD1

Header | Detail | Listing

Tokal 3.00
Discaunt | 0 | 0 | 0 | 0.00
Met: 3.00
Tax | 0.00% " 0.00% " 0.00% | 0.00
Grand Total 3.00

[ Add " Edit " Delete " Search " Print ] [ Exit ]

2.4.5. Cash Sale
This screen is meant for Cash Sales, and it is able to view and modify on the Cash
Receipt’s transactions. (Please take note that any medication on item will not affect the
cash receipts).

Header

~* Cash Sale - CS 00002 =3

Detail || Summary || Listing

Reference Mo, C3 0000z

Date 05/05/2003 14:01 Period
Descripkion CASH SALES (PO3)

Cuskamer Mo, | 99994999 | | CA3H SALES (P0O3)
Counter

Cashier CASHIEE 001

Agent

Member

[ add “ Edit " Delete " Search ” Brint ] [ Exit ]
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Detail

** Cash Sale - CS 00002

Header | i Surmary ” Lisking |

Item No. ITEM 3 |
Descripkion ITEM 3

CQuantity 10.00 |
Price 125.00

Discaunt 0.00% 0.00% 0.00
Tax 0.00% 0.00% 0.00
Amounk 1,250.00

Ikem Mo, Description Cuantity Price Discount Armnount L]
M
B v
Total Amount 1,250.00

[ Add " Edit “ Delete " Search " Prink ] [ Exit ]

Header |Jﬁ||

Total 1,250.00
Discount | 0% 0% 0% 0.00
Met: 1,250.00
Tax | 0.00% 0.00% 0.00% 0.00

Grand Total 1,250.00

Credit Card #1 1,250.00
Credit Card #2 0.00
Cheque 0.00
Youcher 0.00
Deposit 0.00
Cash 0.00
Payment 0.00
Change 0.00
I First " Previous " Mext " Last ] I Add " Edit " Delete " Search " Print ] I Exit ]
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Credit Notes

As customer may have some return goods, those items can be stated in this screen to
make an offset.

Header

** Credit Note - CN 00001

Header |ﬁ” Summary ” Listing |

Reference Mo, CH 00001
Date 23/05/2003 16:51 Periad

Descripkion GOODS REETURN
Customer No. | 2000/000 |+ [cusTomeR 1 | term |
Agent |

Purchase Order No.

Delivery Order Mo,

Coadd | Ede " Delste " Search " Print ] [ Exit l

Details

** Credit Note - CN 00001

Header I Summary ” Lisking |

Item Ma, BARCODE |
Drescription AMANO MTx-10 BARCODE READER
Quantity 1| PC3 |
Price 3,200.00

Discount 0% 0% 0.00
Tax 0.00% 0.00% 0.00
Arnounk 3,200.00

Ikem Mo, Descripkion Cuankity Price Discounk Arnount [
1 BARCODE AMAND MTX-10 BARCODE READE 1PC3 3,200.00 0.00 3,200.00
~
I Add " Edit " Delete " Search " Print ] I Exit ]
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Summary

** Credit Note - CN 000071

Header | Detail isking

Tatal 3,200.00
Discount | 0% " 0% ” 0% | 0.00
Nett 3,200.00
Tax | 0. 00% " 0.00% ” 0. 00% | 0.00

Grand Total 3,200.00

I Add " Edit “ Delete " Search " Print ] I Exit ]

2.4.7. Issue

Issue enables you to enter goods issued for internal use. It consists of three (3) sections:
Header, Detail and Summary.

Header

~* [ssue - 1SS00001 CEX

etail | Summary || Listing

Reference Mo, 15300001
Date 19/05/2003 10:20 Period

Reason I35UE

Authorized By |

I Add " Edit " Delete " Search " Print ] I Exit ]
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Detail

** |ssue - 1SS00001

Header | Summary ” Listing |

Ikem Ma., BARCODE |
Drescripkion AMAND MTx-10 EARCODE READER
CQuantity 1.00 |
Price: 2,500.00

Discount 0.00% 0.00% 0.00
Tax 0.00% 0.00% 0.o0
Armnounk 2,500.00

Ikem Mo, Description Quantity Price Discount Armnount L]
M
Z CANPRIN-2304 CANON PRINTER 1.00 UNIT 530.00 0.00 530.00
v
Total Amount 3,030.00
[ Add " Edit “ Delete " Search " Print ] [ Exit ]
Summary

** |zsue - |S500001

Header ”m | Listing |

Total 3,030.00
Discount | 0% " 0% " 0% | 0.00
Mett 3,030.00
Tax | 0.00% " 0. 00% " 0.00% | 0.00

Grand Total 3,030.00

I Add " Edit " Delete " Search " Print ] I Exit ]

COPYRIGHT © UBS CORPORATION SDN BHD



[ |
h UBS Point Of Sale User Manual Page 51 of 107

User Business System

2.4.8. Adjustment — Increase

The option enables you to increase the stock quantity.

Header

nt - Increase - 0DAID00D1

|m” Summary ” Listing |

Reference Mo, 0AI00001
Date 23/05,/2003 16:54 Perind

Reason ADJUSTHENT

Authorized By |

I Add " Edit “ Delete " Search " Print ] I Exit ]

Detail

** Adjustment - Increase - DAIDDDOT

Header || I Summary ” Lisking |
Item Mo, A4-P-CASE |
Description 44 PAPER CASE
Quankity 10 || SET |
Price Z.00
Discount 0% 0% 0.00
Tax 0.00% 0. 00% 0.00
Amount 20.00

Ikern Mo, Descripkion Cuantity Price: Discounk Arnounk o]
M
~
I Add “ Edit " Delete " Seatrch ” Prink ] I Exit ]
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Summary

** Adjustment - Increase - DAIDDDOT

Header | Detail isting

Tatal 20.00
Discount | 0 | 0s | 0 | 0.00
Nt 20.00
Tax | o.00s| o.o0s| o0.00%] 0.00

Grand Total 20.00

[ Add “ Edit " Delete " Search ” Print ] [ Exit ]

2.4.9. Adjustment — Reduce

The option enables you to decrease the stock quantity.

Header

** Adjustment - Reduce - DARODDOT

Header |Detail summary || Listing

Reference Mo, 0AROOOOL
Date 23/05/2003 17:03 Periad

Reason ADJUSTHENT

Authorized By |

Coadd | Edt " Delete " search ” Brint ] [ Exit ]
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Detail

% Adjustment - Reduce - DARODDO]

Header | Summary J Lisking |

Ikem Ma., BANNEE. |
Description EANNER.

CQuantity & || UNIT |
Price 5.00

Discount 0% 0% 0.00
Tax 0.00% 0.00% 0.o0
Amaount 30.00

Ikemn Mo, Description Quiankity Price Discount Arnounk o]
1 BANNEE. EBANNEE. & TNIT 5.00 0.0o 30.00
~
Total Amaount 30.00
I Add " Edit “ Delete " Search " Print ] I Exit ]
Summary

% Adjustment - Reduce - DARODDO]

Header ”m | Lisking |

Total 30.00
Discount | 0% " 0% " 0% | 0.00
Metk 30.00
Tax | 0.00% " 0.00% " 0.00% | 0.00

Grand Total 30.00

[ Add " Edit “ Delete " Seatch " Print ] [ Exit ]

COPYRIGHT © UBS CORPORATION SDN BHD



EEEEEEEEEEEEEEEE - Point Of Sale User Manual Page 54 of 107

Point Of Sale

User Manual

(Enquiry)

COPYRIGHT © UBS CORPORATION SDN BHD



UserSusines Systam Point Of Sale User Manual Page 55 of 107

CONTENTS

Chapter 3 Enquiry

3.1. PrintBills

3.2. Print Item

3.3. Daily Checkout
3.4. Open Cash Drawer
3.5. Message Display

COPYRIGHT © UBS CORPORATION SDN BHD



UBS

User Business System

Point Of Sale User Manual Page 56 of 107

Chapter 3: ENQUIRY

3.1.

3.2.

Maintenance Transactinn Reports  Housekeeping Help  Exit

Pririt Bill
poi r Frint [temm 3 3
Daily Checkout
rews SRR
M ezzage Dizplay

The ENQUIRY menu is the third menu of P.O.S. System, the report generator for reviewing the
status of the transactions. This Enquiry pull down menu consists of:-

3.1. Print Bill

3.2. Print Item

3.3. Daily Checkout
3.4. Open Cash Drawer
3.5. Message Display
Print Bill

Allow to print out the bill like Stock Receive, Purchase Return, Delivery Order, Invoice, Cash
Sales, Credit Note, Issue, Adjustment — Increase and Adjustment — Reduce.

** Print Bill %]
Reference Mo. Range
Bill Tvpe W |

Reference Mo, from

LJd

Reference Mo, ko ZEEEZEEE
Date Range
Date from 0170171930 00:00
[Dake ko 24/05/2003 00:00
| o4 | Cancel

Select Enquiry - Print Bills > Bills and select the Bill Type, Reference number and date range of
the bill. Click OK button you will able to preview and print the bill.

Print Item

Print Item consists of Item List, Item Label, Category List, Group List and Service Item List.
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Maintenance  Transackion Reporks  Housekeeping Help  Exik

Print: Bills

» |

PO M

Draily Checkouk

3.2.1.

3.2.2.

Item List

Message Display

Ikern Lisk
Item Label

Cakeqory Lisk
Group Lisk
Service Ikem List

Item List enables you to view and print the Item listing in typical or detail format.

** [tem List

Category Fram

Category ko

Group From

Group £o

Item Mo, fram

ZZZZZEZEE

KI[KINKD (KD

CEETZZEE

Item Range

&3

Itemn Mo, ta EEEEECEEEEZEEEEEEEEREEEER
Sork By | Iten No. bl |
Wi |T§gpin:al hd |

| ] 4 | | Cancel |

Select Enquiry - Print Item > Item List and select the Category, Group, Item No. and
select the report to be sorted by Item No., Group or Category.

If you want to see the details report, change the View type from Typical to Detail.

Click on the OK button to preview and print the bill.

Item Label

Item Label enables you to print barcode item label with/without description and unit

price.
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Cateqaory From

Category ko

aroup Fram

Group ko

Item Mo, From

Point Of Sale User Manual

3]

Item Range

ZZEZEZETETE

ZZEZZEZZZE

(Ul (Y

i
i

Itern Mo, ko LEZEEECEZEEZEEEEEEEREEREE
Sork By Iten MNo. V|
| (0] 4 | | Cancel |
Category List

This option enables you to print the item’s category list.

Category From

Cakeqory ko

*“* Category List

Category Range

ZZEZZEZZZ

%]

)
i

| 8]

|| Cancel |

Page 58 of 107

Select Enquiry - Print Item - Category List and select the Category and click on the OK
button to preview and print the list.

Group List

This option enables you to print the item’s group list.

** Group List

Group From

Group ko

Group Range

X]

ZZEZZZ2ZEE

-
i

| 84

| | Cancel |

Select Enquiry = Print Item - Group List and select the Group and click on the OK
button to preview and print the list.

COPYRIGHT © UBS CORPORATION SDN BHD



EEUBS

User Business System Point Of Sale User Manual Page 59 of 107

3.2.5. Service Item List

This option enables you to print the Service Item list.

** Service ltem List

Service Item Range

Service Item From

KI[KD

Service Ikem ko ZEZZZEZEE

Lol oo

Select Enquiry - Print Item - Service List and select the Service Item No. and click on
the OK button to preview and print the list.

3.2.6. Promotional Item List

This option enables you to see the promotional Item list.

** Promotional [tem List 3]

tern Mo, Description Cateqary _Group s

343434
A00001
BANNER. BANNER.

EARCODE AMANOD MTX-10 BEARCODE PEADER
CALENDAR.

CCE BLUE SHIET
CD-COVER

ddds

| €

B | ¥

Iterm Ma. 12312

Description |

3.3. Daily Checkout

This option enables to print out the daily collection by counter according to the date you

specified.
~* Daily Checkout 3
Counter | |E] | |
From Dake 15/05/2003 00:00
To Date 19/05/2003 11:18
view
’ o] 8 ] l Cancel I
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Select Enquiry = Daily Checkout and select the Counter No., date and click on the OK button to
preview and print the list. To print out the summary, change the View type to summary.

Open Cash Drawer

The option enables you to open the cash drawer. Select the Supervisor ID and enter the
password to open the cash drawer.

** Open Cash Drawer r5_<|

Select the supervisor and click Open button to open the cash drawer.

Supervisar b |

Passwiord

Message Display

This option enables you to edit the message to display on the counter machine.

** Message Display le

| W' elcoming |

| Thanking |

| Counter Closed |

Close
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Maintenance Transackion Enguiry W=l

Cash and Receipt Reports

Sales Reports

pointof
.

Irventory Reparts

Membership Report

Managerment Reporks

8 Housekesping Help

3
3
4

The REPORTS menu provides most up-to-date detail or summary reports, where it categories

into:-

4.1
4.2
4.3
4.4
4.5

Cash and Receipt Reports
Sales Reports

Inventory Reports
Membership Report
Management Reports

Cash and Receipt Reports

Cash and Receipt Reports consist of Receipt Report, Sales Order Report, Cash Recording Report,
Credit Card Report, Cheque Report, Voucher Report, Special Discount Report and Free Item

Report.

Maintenance  Tranzaction  Enguine B5E

Cazh and Feceipt Reports

Salez Reports

pointof

|nventory Reparts
tembership Feport

M anagement Reparts

4.1.1. Receipt Report

Houzekeeping Help  Exit

Feceipt Feport
Salesz Order Report

Cazh Recording Report
Credit Card Feport
Cheque Report

Special Dizcount Report

Receipt Report indicating the type of payment made by Customer including the receipt

number and amount paid.

** Receipt Report

Cashier Range

Zashier from B
Cashier ta [AAAAAAAA B
Counter From B

Counter ko

ZEZZEEZE E]
Date Range

Date from o1/01/2001 |EID:EID
[Date ko 21/05/2003 00:00
Wiew Typical hd
Receipt Status Typical b
[ oK I [ Cancel I

|!
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Select Reports - Cash and Receipt Reports - Receipt Report, key in the Cashier
number, counter and date. Select the view type whether to print out Typical, Summary,

Credit Card, Credit Card Summary, Transaction Detail, Tax Details or Payment Analysis.
Choose the Receipt Status and click on OK button to preview or print the Receipt Report.

Sales Order Report

Sales Order Report enables you to view and print the sales order made by customer.

** Sales Order Report @

Cashier From E]
]

Cashier to EEEEEEEE

Salesperson / Agent

Agent bo ZLEZZEZEEEZEEE

Agent From E]
M

Date Range

Crate From Nl/01/2001 00:00
[ake ko 2170572003 00:00
Sark By Cashier W
Wiga Typical hd
Crder Status Typical hd

| (] 4 || Cancel |

Select Reports - Cash and Receipt Reports - Sales Order Report, key in the Cashier no.,
Agent code and date. Select the view type to print out Typical or Summary Report.
Choose the Order Status and Click on the OK button to view and print the Sales Order
Report.

Cash Recording Report

Opening is the money hold by Cashier before starting work. Cash In is the money add in
during work and Cash Out is the money to be withdrawn from the Cash Drawer when
Cashier finishing work.

Cash Recording Report usually printed for checking purposes to control the money in and
out.
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** Cash Recording Report [5_<|

Cashier Range

Cashier Fram

Cashier ta LEEEZEED

Counker From

(JdJ (Jd

Counker ko ZEZEZZEE
Date Range
Date From 0140142001 |oo:oo
[ake ko 21740572003 00:00
Wi | Typical hd
Transaction Skakus Typical b
| (] 4 | | Cancel |

Select Reports > Cash and Receipt Reports - Cash Recording Report, key in the
Cashier no., counter and date. Select the view type to print out Typical or Summary
Report. Choose the Transaction Status and Click on the OK button to view and print the
Cash Recording Report.

4.1.4. Credit Card Report

Credit Card Report enables you to view and print the sales paid by Credit Card.

** Credit Card Report [Z|
Cashier Range
Cashier From E]
Cashier ko ZZEEZEEE E]
Credit Card From MALSTER. CREDIT CAERD b
Credit Card ko WI3A CREEDIT CARD il
Date Range
Drate From Nl/01/2001 00:00
Date ko 2170542003 00:00
Wiga Typical e
Transackion Skatus | Typical hd
ok | | Cancel |

Select Reports > Cash and Receipt Reports - Credit Card Report, key in the Cashier no.,
Credit Card Type and date. Select the view type to print out Typical or Summary Report.
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Choose the Transaction Status and Click on the OK button to view and print the Credit
Card Report.

Cheque Report

Cheque Report enables you to view and print the sales paid by Cheque.

** Cheque Report f'5_<|

Cashier Range
Cashier Fraom E]

Cashier to ZEEETEEE

Date Range

Dake Frarm Nl/01/2001 00:00
Date ko 2140572003 00:00
Transaction Skakus |T§gpi|:al V|

Select Reports - Cash and Receipt Reports - Cheque Report, key in the Cashier no.,
and date. Choose the Transaction Status and Click on the OK button to view and print
the Cheque Report.

Special Discount Report

Special Discount Report enables you to view and print the special discount list if you
have set in your maintenance.

= GCpecial Dizcount Report [EI
Cashier Range
Cashier Fram | E]
ashier ko EEEEELELE E]
Discaunt Fraom NEW YEAR PROMOTION bl
Discounk o NEW ¥EAF PROMOTION e
Dakte Range
Date From 0140141930 00:00
Date to 250542003 00:00
Wigw Typical b
Transaction Status Typical b
| (] 4 | | Cancel |
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Select Report - Cash and Receipt Report = Special Discount Report and select the
Cashier code, discount code and date. Select the view type to print out Typical or
Summary Report. Choose the Transaction Status and Click on the OK button to view and
print the Special Discount Report.

Sales Reports

Sales Report consists of Product Sales Report, Service Item Report, Salesperson Sales Report,
Promoter Sales Report and Time Report. Where it enables you to view and print various reports
on Sales Analysis. These reports will give you on-hand information of Sales performance.

Maintenance Transaction  Enguiry BEEssed Houzekeesping Help  Exit

Cazh and Receipt Reports r
poi nt O-I Sales Feports Product Sales Report
Inventory Reports k Service ltem Report
_ Memberzhip Report 4 Salezperson Sales Report
Fromoter Sales Report
M anagement Reportz k F

Time Report

Free lkem Report

4.2.1. Product Sales Report

Product Sales Report enables you to view and print sales value by product.

** Product Sales Report §|

Item Range

Cateqory From E]
Category ko EEEEZEEE E]
Group Fram E]
Group ko EZEEZZZE E]

Ikem Mo, From

]
]

Item Mo, to EEEEEZEEREEREEEREEREEERER

Sork By Itenm No. b

Drake From 0l/01/72001 00:00

Date ko 2170572003 00:00

Wig Typical b
............. QKH —

Select Reports - Sales Reports - Product Sales Report, key in the Category, Group,
Item No., and date then click OK button, you will able to see the Product Sales Report.
You are able to sort the report by item no, group and category. Select the View Type to
print out the Typical report, Monthly Sales, Monthly Volume, Quarterly Sales, Detail
report or Typical Receipt Layout.
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Service Item Report

Service Item Report enables you to view and print the sales value and transaction of
Service Item.

** Service ltem Report r5_<|

Service Item Range

Service Ikem From

Service Ikem ko ZEZZZZZE E]

Date Range

Date From 01/01/2Z001 00:00

Drate ko £1/05/2003 00:00

Yiew Typical V|
| ............ OK ............. | | - |

Select Reports - Sales Reports - Service Item Report and key in the Service Item Code
and date then click OK button, you will able to see the Service Item Report. Select the
View Type to print out the Typical or transaction report.

Salesperson Sales Report

Salesperson Sales Report enables you to view and print the Sales Value, Sales
Transaction, Product Detail and Performance Analysis by Salesperson.

** Salesperson Sales Report r5__<|
Salesperson / Agent
agent From E]

Agent £o ZEEZZZEZZEEZIEE

Date Range
Crate From 0ls01/2001 00:00
Date to 2170572003 00:00
Yigiy Typical b
Sork By Total Transaction
(04 || Cancel |

Select Reports - Sales Reports - Salesperson Report and key in the Salesperson/Agent
Code and date then click OK button, you will able to see the Salesperson Sales Report.
Select the View Type to print out the Typical Report, Transaction, Product Detail or
Performance Analysis. For Performance Analysis Report, you are able to sort by Total
Transaction, Gross Total or Grand Total.
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Promoter Sales Report

Promoter Sales Report enables you to view and print the sales value by promoter.

** Promoter Sales Report r5_(|

Promoter Range
Promoter Franm E]

Promoker to CEZEZEEE

Date Range

Drate From 0l1/01/2001 00:00
Date ko 2170572003 00:00
o Cancel

Select Reports - Sales Reports - Promoter Sales Report and key in the Promoter Code
and date then click OK button, you will able to view and print the Promoter Sales Report.

Time Report

Time Report is indicating the time of the Salesperson selling the product to the customer.
Usually this time will appear on the receipt of the Salesperson.

** Time Report

Cashier Range
Cashier Fram B
Cashier ko EEEEEZEET B
Counter Fram B
Counker o EEEEEZEE E]
Date Range
Diake From 017012001 O0:00
Dake ko 217052003 a0:00
Wiew | Typical il |
[ o4 ] [ Cancel ]

Select Reports - Sales Reports - Time Report, key in the Cashier no., counter and date.
Select the view type to print out Typical or Analysis Report. Click on the OK button to
view and print the Time Report.

Free Item Report
Free Item Report enables you to view and print Free Item, which it comes together with

the item. If you have already keyed in the free item then you will be able to print this
report.
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=% Eree ltem Report ®

Item Range

Cateqary From E]

Category to EEEEEEEE E]

aroup From E]

Group ko ZZZZZEZZE E]

Item Mo, from E]

Item Mo, to FEEZEZEIEZEZERLEEREERREEZEE E]

Sork By | Iten No. Vl

Date Range

Crate From 0l/01/1930 00:00

Date ko 25/05/2003 00:00

Wi Typical V|
| 04 | | Cancel |

Select Reports - Sales Reports - Free Item Report and select the category, group, item
no., and date then click on OK button to view and print the report. You are able to sort
the report by item no, group and category. Select the View Type to print out the Typical
or Detail report.

4.3. Inventory Reports

Inventory Reports consists of Stock Balance Report, Inventory Physical Worksheet, Stock Receive
Report, Purchase Return Report, Stock Return Report, Stock Adjustment Report, Reorder Advice
and Serial No. Report.

Maintenance  Transaction  Enquiry BEEEEN Housekesping Help  Exit

Cazh and Receipt Reports 4
po i “t O-I Sales Reports »
Irwentary Reports Stock Balance Repaort
_ Membership Report R Inventory F'P?ysical Work sheet
Stock Receive Feport
Management Reparts b Purchase Return Report

Stock Return Report
Stock Adugtment Report

Reorder Advice

Serial Mo, Report
|tem Grade Report
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4.3.1. Stock Balance Report

4.3.2.

Stock Balance Report indicates those stocks are still available.

** Stock Balance Report

Cakegary From
Cakegory to
Group From
Group ko

Iterm Mo, From

Item Mo, ko

ZZEEZZEE

ZZEEZZEE

(JJ U]

3

Item Range

CEEEZCEECCEEEEEEECEZEEEE

(dtd

Sork By

Dake From

Crake ko

iew

Skock Stakus

| Item HNo.

Date Range

£oof
Z1/05/2003
Typical it
Typical -
ok l [ Cancel

Page 71 of 107

Select Reports - Inventory Reports - Stock Balance Report and select the category,
group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Change the view type from
Typical to Detail to see the detail report. To print out only Active Item, you can change
the Stock Status from Typical to Active Item.

Inventory Physical Worksheet

Inventory Physical Worksheet like a check list for the user to do the Inventory check.

** [nventory Physical Worksheet

Item Range

Cateqgory From

Cakegory ko

Group fram

Group to

Item Mo, From

ZEZZEZZZ

CEEZEZZZE

(JCJ (i

K3[KD

Itern Ma, ko CECZECCECZEECZEEZEEZREZEE

Sart By | Item No. v |
Date Range

Date Fram FA)

Date ko Z1/08/2003

|

Cancel
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Select Reports - Inventory Reports - Inventory Report and select the category, group,
item no., and date then click on OK button to view and print the report. You are able to
sort the report by item no, group and category.

Stock Receive Report

Stock Receive Report will indicate the stock received for viewing and printing purposes.

** Stock Receive Heport [‘S_<|
Item Range
Category Fram | E]
Category to EEEEEEEE E]
aroup Fram E]
GEroup ko ZEEEZEEZE E]
Itern Mo, From E]
Ikem Mo, to ZEFEZEEEEEELEZEREREEZEEE E]
Sork By | Item No. bt |
Date Range
Crake From F
Dake ko 21405742003
Wie Typical hd |
| of | | Cancel |

Select Reports - Inventory Reports - Stock Receive Report and select the category,
group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Select the View Type to print out
the Typical report, Monthly Purchase, Monthly Volume, Quarterly Purchase or Detail
report.

Purchase Return Report

Purchase Return Report enables you to view and print a list of transaction on Purchase
Return in details.
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** Purchase Return Report rg|

Item Range

Date fram

Date ko

Wiew

Cabeqory fram E]
Categary ko ZEEZEZEEE B
Group fram E]
Group to EEZZZEZEED E]
Item Mo, From B
Item Mo, to ZEZEEEEEEZEEEEEREEEEEEER E]
Sark By | Itenm Na. b |

Date Range

foF

2l/05/2003

Typical V|
QK H Cancel ]

Page 73 of 107

Select Reports - Inventory Reports - Stock Receive Report and select the category,

group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Select the View Type to print out
the Typical or Detail report.

Stock Return Report

Stock Return Report enables you to view and print Stock Return by product.

** Stock Return Report _

Item Range

Cakeqgary Ffrom

Cakegory bo

Group From

Group ko

Ikem Mo, From

Iter Mo, to

ZZEZZEZZZE

ZEZZZZZZZ

(JdJ [did

EECCZEEEEECEEEEEEEEEEEEE

Ki(K)

Sark By

Diake From

Diake to

Wiew

|Item Mao.

4|

Date Range

;oS

2170572003

Typical
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Select Reports - Inventory Reports - Stock Return Report and select the category,
group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Select the View Type to print out
the Typical or Detail report.

Stock Adjustment Report

Stock Adjustment Report enables you to view and print if there is any stock adjustment
transaction.

% Stock Adjustment [x]

Item Range

Cakeqgary Fram | E]
Caktegory ko :4-4:4-4:4-4-4-4 E]
Group From B
Graup ko ZEEEEEZE E]

Itern Mo. From

KI[KD

Ikermn Mo, ta CEEEEEZEEEEERCEEEEEZEEER
Sork By Item No.
Dakte Range
Date from I
[rate to 25/05/2003
Yigw Typical 4
l oK ] ’ Cancel ]

Select Reports - Inventory Reports - Stock Adjustment Report and select the category,
group, item no., and date then click on OK button to view and print the report. You are

able to sort the report by item no, group and category. Select the View Type to print out
the Typical or Detail report.

Reorder Advice

Reorder Advice enables you to view and print item’s reorder list when the quantity on
hand is lower than the minimum level.
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** Reonder Advice

Item Range

Cakegary From

Cakegory ko

Group Fram

Group bo

Iterm Mo, From

CEZZZZEE

ZZZZZZZIZ

KI[KINKDKD

Ki[KD

Item Mo, ko CEEZZZEZZEZEZZEEEEZEEEEREEE
Sark By | Iten No. i |
Date Range
Date From A,
[rate o 21/08/42003
Wiew Typical V|
[0 4 ] [ Cancel l

Page 75 of 107

Select Reports = Inventory Reports - Reorder Advice and select the category, group,
item no., and date then click on OK button to view and print the report. You are able to
sort the report by item no, group and category. Select the View Type to print out the
Typical or Detail report.

Serial No. Report

Serial No. Report enables you to view and print the serial numbers'’ status.
Item’s serial number such as hand phone, the serial number comes together with the

item.

** Senal No. Heport

Item Range

Cateqory From

Z_aktegory ko

Group From

aroup to

Item Mo, From

Ikern Mo, ta

%]

ZZEZZZEE

ZZZZZEZZZ

(W Uty

CEEEZCECEEECZCEEEEEEEEEEE

)
M

Sork By

Date From

Date ka

Wigw

| Item Mao.

¥

Date Range

01/01/1930 00:00

2570572003 00:00

a1l
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Select Reports - Inventory Reports - Serial No. Report and select the category, group,
item no., and date then click on OK button to view and print the report. You are able to
sort the report by item no, group and category. Select the View Type to print out the all,
available item or sold item.

Item Grade Report

Item Grade Report enables you to view and print the graded item list. If you have
assigned any item with grades, then you will be able to see the regent as below:

** |tem Grade Beport 3]

Item Range

Cateqary From E]
Category Lo EEEEEEEE E]
Group From E]
Group Eo ZEZZZEEZE E]

Item Mo, fram

K1 [KY

Ikemn Mo, ta CEECEECEEZEZEZEEELEERELEER

Sork By | Iten No. V|
Dake Frarm 01/01/1930 00:00

Drate ko 25/05/2003 00:00

Yig Status v|

Select Reports - Inventory Reports - Item Grade Report and select the category,
group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Select the View Type to print out
the item status or sold item.

Membership Reports

Maintenance  Transaction  Enguing SR

Housekeeping Help  Exit

Cazh and Receipt Repaorts 3
poi nt O-I Sales Feports »
Ihwventary Reports 4

_ b embership Fepart Member Sales Feport

Point Accumulated Report
kM anagement Reports 4

bk ember Birthday Report
termberzhip Expired Report
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Membership Reports consists of Member Sales Report, Point Accumulated Report, Member
Birthday Report and Membership Expired Report.

4.4.1. Member Sales Report

4.4.2.

Member Sales Report enables you to view and print the Membership’s transaction

records.

Merber From E]

Member ko CECCCEECEZEEZEEEEEREE

Sork By |Hemhership Ho. V|

Date Range

Date From 0ls01/1930 00:00
Date to 2570572003 00:00
Wig Typical V|
| Ik || Zancel |

Select Report > Membership Reports > Member Sales Report and select the
Membership No. and the transaction date then click on the OK button to view and print
the Member Sales Report. You are able to sort the report by Membership No. or Name.

Point Accumulated Report

Point Accumulated Report enables you to view and print he Points collected by the

Members.

% Point Accumulated Beport EI
Member Range

Mernber Fram

K1)

Mernber ko ZEEZEEZEEEEEREZEEEERE
Sork By |I-![em.bership Ho. 1"*’|
Wig |All V|

............ 0 K| | p— |

Select Report > Membership Reports = Point Accumulated Report and select the
Member ID. and click on the OK button to view and print the Point Accumulated Report.
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You are able to sort the report by Membership No. or Name and change the view type to
print only active member.

Member Birthday Report

Member’s Birthday Report enables you to view and print the member’s birthday date.

& Member Birthday Beport 3]
Member Range
Merber From E]
Member ko ZECECEECEZCELEEEEEEEE E]
Sork By Membership No. V|
Wi a1l h |
Manth January 9
(0] 4 | | Cancel |

Select Report > Membership Reports > Member Birthday Report and select the Member
ID. and birthday month and click OK button to view and print the Member Birthday
Report. You are able to sort the report by Membership No. or Name and change the view
type to print only active member.

Membership Expired Report

Membership Expired Report enables you to view and print report on the member’s
expiration date.

% Membership Expired Beport

Member Range

Member Fram E]
Member ko EEZCEZEEEEEEEEEZEEREE E]
Sork By Membership No. V|
Yiew 4ll ~ |
Month Jaruary bt
| ] 4 | | Cancel |

Select Report - Membership Reports - Membership Expired Report and select the
Member ID. and birthday month and click OK button to see and print the Membership
Expired Report. You are able to sort the report by Membership No. or Name and change
the view type to print only active member.
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4.5. Management Reports

Management Report enables you to view and print the reports like Salesperson Performance,
Member Analysis, Product Analysis, Payment Analysis and Time Analysis.

Maintenance Tranzaction Enguiry BEESNEN Housekeeping Help  Exit

Cazh and Receipt Reports 4
oi nt 01 Sales Reports »
p Irventary Reports 4

Mew Member Management Reparts Salezperson Performance

HEeCent ACCess :
Mew Product Arrival Member Analysiz

Today's Sales Praduct Analysis

Payment Analysis

Time Analpsiz

4.5.1. Salesperson Performance

Salesperson Performance Report enables you to view and print report base on the sales
value.

% Salesperson Performance

Salesperson / Agent
fgent Fram |

Agent ko EEZZZEEZEEZE E]
Dakte Range

Date From 0170171930 00:00
Date to 250572003 00:00
Sork By Total Transaction b
| oK || Cancel |

Select Report > Management Report > Salesperson Performance and select the
Salesperson/Agent No. and date then click on OK button to view and print the
Salesperson Performance Report. You are able to sort the report by Total Transaction,
Gross Total or by Grand Total.

4.5.2. Member Analysis

Member Analysis enables you to view and print the member’s geographical area,
demographic age or top purchases member.
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** Member Analpsis

IMember From

Member Range

]

Ki[KD
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Member ko ZEZEZEZEEZEZZEZZEZREZZEEE
Saork By |Hembership No. V|
Date Range
Dake From 0170171930 00:00
Dake ka 25/05/2003 00:00
Wi Geographic o~
Geographic City
Top 50 Records
[ oK ” Cancel l

Select Report > Management Reports > Member Analysis and select the Member ID.,
date and other necessary option then click on OK button to view and print the Member
Analysis Report.

Product Analysis

Product Analysis Report enables you to print out the product’s profit margin, top sales
and low demand product.

X

Item Range

Category From

** Product Analysis

Categary ko ZEEZZEEZEE

Group Fram

KIKIIKI (KD

Group ko LEEEEEER

Item Mo, From

KI[KD

Ikem Mo, ko CECEZLEELELELEEECEEEEEEEE

Sart By | Iten No. b |
Date Range

Drake From 0170172001 00:00

Drate to 21/05/2003 00:00

Yig Profit Margin v|
Top 50 Records

Select Reports > Management Reports = Product Analysis and select the category,
group, item no., and date then click on OK button to view and print the report. You are
able to sort the report by item no, group and category. Select the View Type to print out
the Profit Margin, Top Sales Product or Low Demand Product.
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4.5.4. Payment Analysis

Payment Analysis Report enables you to view and print the total sales value by different
payment mode.

A% Papment Analyzis 3]
Cashier Range

Cashier from

Cashier to ZEZEZEEEEE

Counter Fram

(J0d (U]

Counter ko ZEZEEEEE
[rate From 0170141930 00:00
[rate ko £5/05/2003 00:00
Receipk Skatus | Typical 4 ‘
I O ” Cancel ]

Select Report > Management Reports - Payment Analysis and select the Cashier Code,
Counter No., date and other necessary option then click on OK button to view and print
the Payment Analysis Report.

4.5.5. Time Analysis

Time Analysis Report enables you to view and print reports on number og sales made
with certain timeframe.

£

% Time Analyzis

Cashier Range

Cashier Fram |

Cashier to EEEEEEEE

Counker From

KIEIEIEY

Counker o ZEZEZEZEE
Date Range
Date From 010141930 00:00
Dake ko 2570572003 00:00
I oK ] I Cancel ]

Select Report > Management Reports - Time Analysis and select the Cashier Code,
Counter No. and date and then click on OK button to view and print the Time Analysis
Report.
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Chapter 5: HOUSEKEEPING

Maintenance Transaction Engquiry Feports II@M Help  Exit

Sekup 4

poi “t Of sa I Administrative Tools L4

Index Database

Backup and Restore
UB! Import and Export ¥

Copyr

Zhange Password

This Select Prinker. ..

IJBS Corporation Bhd

The HOUSEKEEPING menu is not just dedicated to data maintenance only, it also involves in
configuring the entire system settings. The Housekeeping pull down menu consists of: -

5.1. Setup

5.2. Administrative Tools
5.3. Index Database

5.4, Upgrade Database
5.5. Backup and Restore
5.6. Import and Export
5.7. Change Password
5.8. Select Printer

5.1. Setup

Setup menu consists of General Setup, Transaction Setup and Device Setup.

Maintenance Transaction Enquity Reporks NERNEEEEEWGN Help  Exit

po i nt Of sa I Adrinistrative Tools 3 Transackion Setking

Device Setkin
Index Database d

Backup and Restare
UB! Import and Export 3

Copyr . all rights reserved,

Change Password

This | Select Printer. ..

5.1.1. General Setup
Company

User needs to enter their Company Detail, General Setting, Regional Setting and
Database Integration Setting accordingly.
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** General Setup [5_<|

General || Reqgional || Sharing

Company Profile

Company Mame UEBS Corporation Ehd

Address Lewel 51, Tower Z, Petronas Twin Tower,

Kuala Lumpur City Centre,

5005858 Euala Lumpur.

Telephane 603-2031 6178
Fax 603-2031 5425
RO Mo, 441359-K

Apply Multi-Compary

EEEEET

The Company screen involves licensing not only company who purchase the software, it
also concern the registry of the accounting entry and output. Please indicate the
company with correct ROC number, so the account can be recognized as valid. If you
prefer to have multi-company account, please tick the Apply Multi-Company check box.

Apply Multi-Company - allows user to create multiple company to maintain
different sets of P.0O.S. system.

General

** General Setup

x)

| Reqional || Sharing

Accounting Period

@3 Lask ¥ear Accounting Closing Date al/lz/z002
This Accounting Year Closing Period 15 =

FromDate | 01/01/2003 | To | 30/06/2004 |

Smart Lock Setting

Company

EEAHK Smart Lack Type |Dem0 Set "|
[ Ok l l Cancel ] l Apply ]
Last Year Accounting Closing Date - Closing date indicate the last accounting

year. It must be same with UBS Stock
Control system.

This Accounting Year Closing Period - Closing period indicate the number of

months for this accounting year. It must
be same with UBS Stock Control system.
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Smart Lock Type - Please take note that if you purchased
and setup the full version of P.O.S.
system, there should display a word
Licensed edition at the Login screen
when you run the P.0.S. system.

Regional

This option enables you to maintain the currency use by company and to set the
quantity, price, discount percentage, NRIC and date format use in the system.

Company || General | Regional |Sharing

Currency and Numbers
Currency Symbol M

Currency Wwiord Ringgit M'sia |

The number Farmat is represented by 9, For example : 9,999,999 ,99 or 99%,,

Quankity 9,999,999 Amounkt 9,999,999, 39
Price 9,999,999,99 Cash Amount 9,999,993,99
Discount Percent 99%

MRIC Ma. |999999—99—9999 |

Date Format | Default b |

Sharing

This option enables you to set the linkage to Stock Control and Accounting System.

Company || General || Regional | Sharing |

Database Integration

& Inteqgrate wikh Skock Cankral System
B 9

Stock Control Folder | d:yubzstkdatal |E]

|:| Integrate with Accounting System

Accounting Folder | |

(o J( o J[ o0 ]
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5.1.2. Transaction Setup

Function

Page 87 of 107

This allows you to integrate the P.O.S.
system with Stock Control system by
direct it to the specific directory.

This allows you to integrate the P.O.S.
system with Accounting system by
direct it to the specific directory.

** Transaction Setting

Transaction

Appearance || Controls || Pavment || User Defined

Salesperson | Agent [ImMultiple Lacation
Customer Table
Promater

Setvice Ttem Change Pricing
Promotional Item Ikem Grouping
Free OF Charge Item Repeat Lask Tkem

Exchange or Return Item

Tax

Enktry Activaktion

Item Function Activation

Security

Miscellaneous || Format || File Locations

[ ]Preset Quantity
|:| Preset Price

|:| Preset Discount Percent

(o Jom [ ow ]

Tick the Entry Activation check box to activate the entry screen for the
Salesperson/Agent, Customer, Promoter, Multiple Location and Table.

Item Function Activation uses to control the following functions:-

«  Service Item

» Graded Item

*  Promotional Item

»  Free of Charge Item

«  Exchange or Return Item
« Change Pricing

« Item Grouping

* Repeat Last Item

*  Preset Quantity

»  Preset Price

»  Preset Discount Percent
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Appearance

** Transaction Setting

Transackion Securiby

Functions Contrals || Payment || User Defined || Tax || Miscellanecus || Format || File Locations

Screen Appearance

|:| Company Logo Function Key Legend
|:| Previous Reference Mo,

[ IMext Reference Ma.

Item Appearance

Drescripkion Functional b Ciscount Percent #1 Functional hd
Cuankiby Functional hd Discounk Percent #2 Functional hd
it OF Measure Functional w Discount Functional b
Price: Functional i Armaunt Functional B
[ ok I [ Cancel ] l Apply ]

Allow the system to set to show, hide or disable the company logo, Reference No.,
Function Key, Item Description, Quantity, Unit of Measurement, Price, Discount
Percentage, Discount, Amount and Grid Line.

Controls
** Transaction Setting fg|

Transaction Security

Functions Appearance| |Payment User Defined || Tax || Miscellaneous || Format || File Locations

Item Control

[ allows item ta be sold lower than unit cost
[] allow to proceed when on hand quantity is nok enough

[] allow ta edit item during transaction

Summary Control

[ allow o edit discaunt
[ allow ta edit bax

The Item Control and Summary Control consist of:-
« Allow item to be sold lower than unit cost
»  Allow to proceed when on hand quantity is not enough
» Allow to edit item during transaction
« Allow to edit discount
»  Allow to edit tax
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Payment

** Transaction Setting fg|

Transaction Security

Functions || Appearance Contrnls| |User Defined || Tax || Miscellaneous | Format || File Locations

Payment Accepltance

Credit Card Youcher [CFareign Currency
[ Debit: Card [ Deposit
Cheque

Cheque

[ Always enter bank.
[ ] Always enter cheque number

[ ] Always enter cheque date
The post dated chegue (PDC) only accept within dawis)

[]special Discount

(o J( o J[on ]

This page is use to set the payment acceptance and the require fields to fill in if pay by
cheque.

User Defined

** Transaction Setting

Transackion Securiby

Functions || Appearance || Controls | Payment | User Defined |Tax Miscellaneous || Format || File Locations

Header User Defined
Bpply  Descripkion Length Formak ~
' ==
]
]
[ v
Body User Defined
Bpply  Descripkion Length Formak ~
M
0 =
]
] v

R

Users are able to define their own field into database for the user to update during Cash
Receipt in transaction.
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Tax

** Tranzaction Setting 3]

Transaction Security

Miscellaneous || Format || File Locations

Functions || Appearance || Controls || Pavment || User Defined

Tax Computation

[ apply Tax
Descripkion e Forrula Compulsary
Goverment Tax 5% 5.00 : SUBTOTAL * (TAXPERCENTL /s 1l00) Yes b
o.o0 % Ho ¥
0.00 % Ho ¥
[] Tax Inclusive
Sample

Government Tax 5%: SUBTOTAL * (TAXPERCENT1 / 100)

Service Charge 3%o: SUBTOTAL * {TAXPERCENTZ / 100)

(o J(ew J[om ]

Select the checkbox “Apply Tax” if you want to calculate tax on the total of that

transaction.

Description - enter the description for tax so that it will appear in the
cash receipt.

Percentage - enter the percentage (%) so that it will appear on the cash
receipt.

Formula - enter the formula to calculate the tax amount.

Miscellaneous

** Transaction Setting E|
Transackion Security

Functions || Appearance || Controls || Payment || User Defined Tax| |Format File Locations

Default Setting

Salesperson [ Agent B
Accounting Project B
Ikem Location WARE |E]
Ikem Description First i
Ikern Pricing Price & i
Ikem Type Stock Item i

Membership

[ ]apply Membership

Item Discount

Summary Discounk Collection Method | Total Purchased |

Ratio (Point : Amount) | 1] | 1.00 |

(o (e J o ]
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The page enables you to set the default value for the Salesperson/Agent, Accounting
Project, Item Location, Item Description, Item Pricing and Item Type.

For those who want to maintain the membership type of system, please preset the
membership’s structure in the above page.

Format
** Transaction Setting g|

Transaction Security

Functions || Appearance || Contrals || Payment || User Defined || Tax || Miscelaneous | Format | File Locations

Reference Number Format

Tvpe Auko Current Mo, Prefix A
y

Credit Note 1| om

Cash Zales 7| cs
Delivery Order 3 na
Invoice 2 Inv
Izzue 2 I35 hd

Key Field Format

Item Mumber |

Membership Mumber

ERETTT

Having trouble to allocate the reference numbers for transaction?

This Reference Number Format section allows you to set your transaction reference
number to auto-run and prefix it. These will also eliminate the chances of duplicated
reference number.

On the Key Field Format section, it allows you to indicate the number format for item
entry and membership number.

* Please take note that Item Number Format must be same with Stock Control system if
Integrated.
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File Locations

** Transaction Setting E|

Transackion Securiby
Functions || Appearance || Conkrols || Payment || User Defined || Tax || Miscellaneous || Format |
Title File: Lo ation ~
> |
Receipt #2 rprtosfrp. frx
Receipt #3 rprtosfrp. frx
Invoice rpring0l. frx
Sales Order #1 rprtsof0l. frx
Salez Order #2 rprtsofl2. frx
i
[ oK l [ Cancel ] ’ Apply ]

Click on the Properties button to select the format file for Receipts, Invoice and Sales
Order. This option allows you to set and customize the format of the report to be printed.

Transaction
** Transaction Setting (%]
Functions || Appearance || Controls || Payment || User Defined || Tax || Miscellaneous || Format | File Locations
Transaction | Security
Transaction Activation
Sales Order
Makure of Transaction | Retail hd |
[ oK l [ Cancel ] [ Apply ]

Click on the Sales Order check box to activate the Sales Order function and select the
nature of business of your company whether is Retail shop or Restaurant.
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Security

** Transaction Setting r5__(|

Functions || Appearance || Controls || Payment || User Defined || Tax || Miscellaneous || Format || File Locations

Transaction | Security

Supervisor Approval

[¥]hen exchanged or returned of item
['when accept sales order

(o [ I o

To set the security level as management wishes and have to determine whichever
necessary check box to be ticked.

5.1.3. Device Setup
Cash Drawer

This section allows you to configure setting for the Cash Drawer.

** Device Setting El

Cash Drawer |Customer Display || Scale

Cash Drawer Setting

Connect ko Cash Drawer

<

Comrnunicakion Park COML

Baud Rate 2600

Trigget Drawer Command | CHR (7]

Mo, of attempk when trigger the drawer 1|5

Open the drawer when the following action is taken

[Jecredit Card Payment [Jcheque Payment [bepasit
[Jmebit Card Payment [woucher [ cash Recording
[ QK I l Zancel I [ Apply ]

Connect to Cash Drawer - Tick check box to enable the control link to the cash drawer.

* Baud Rate and Trigger Drawer Command are common Setting, changes could be
needed for different hardware.
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Customer Display

Ever notice the small screen or LCD that display your purchase payment above the cash
dispenser in supermarket? This screen allows you to make some arrangements and
settings for the mechanism.

** Device Setting §|

Cash Drawer ‘ Customer Display | Scale

Customer Display Setting

Connect ko Customer Display Device

Comrunicakion Port COMl
Baud Rate 9600
‘Welcoming Message HLPPY NEW YE&AR

*% WELCOME **

Thanking Message THANE Y017

PLEASE COME AGATN

Counter Closed Message COUNTEER. CLOSED

NEXT COUNTEE. PLEAZE

Reset back to welcoming message after seconds
Tes

Scale
This section allows you to set the barcode’s scale.

** Device Setting 3]

Cash Drawer || Customer Display | Scale |

Scale Barcode Setting

Accept Scale Barcode

Flag Digit

Start End Decimal
Tkern Mo, <) 7 |%
|:|Price g 12 2
[#] Guantity 8% 12 % 2%

Round Up Quantity
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5.2. Administrative Tools

This option contains of user manager, policy setup, database viewer, language editor and font
editor.

Maintenance Transaction Enquiny  Reports

p oi “t Of s a I Administrative Tools Uszer Manager

Palicy kManager
Index Databaze v d

_ Upagrade Databaze Databaze Viewer

Backup and Restore Databaze Clearance
Import and Export 4 Recover Databaze

“fear End P i
Change Pazsword ear End Processing

Language Editor
Fant E ditor

Select Printer...

5.2.1. User Manager

This option enables the user to create the user login id and assign the access level to the

user.
** LUser Manager, E|
[ | Listing
ser ID UES
Marne Defanlt User
Password wwE

Retype Password wEE

User Group ADMIN Administrator

| add ” Edit || Delete || Exjt |

1. Click on the “"Add"” button to add a new use id. Next, type in the user id, name and
password.

2. Select the appropriate user group. Refer 4.3.1 for user group setup.

3. System administrator has the authority to access into all the system, click on the
“System Administrator” check box to assign a system administrator.

4. For any in-active user id, click on the “Suspend” check box to terminate the user access
right.

5. Click on the “Save” button once you have completed key in the relevant information.

6. Click on the “Edit” button for you to modify the description.
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7. To delete the record, click on the “Delete” button.

8. Click on the “Exit” button to exit.

5.2.2. Policy Manager

This option enables the user to define the user group’s accessibility into the system.

~ x|

Policy | isting

Group ATDMIN
Marme Addwinistrator
[tem Type Arcess Create Edit Delete Print ~

W

’ add “ Edit “ Delete H Exit l

1. Click on the “"Add" button, key in the group id and name.
2. There are two ways to set the authority for the group.

a. Click on “Item List” button

i. Click on the “Item List” button and select the form name from the list to assign
the authority of the group to access to the form.

b. Click on “Capture” button

i. Click on the “Capture” button, the group policy form will be minimized to the
bottom of the screen.
ii. Activate the form you want to capture.

iii. Press and hold the Ctrl button, use your mouse to point to the edge of the form
until you see a text icon displayed.

iv. Drag and drop the text icon into the “Tray” show on the top of your screen.
v. Click on the “Tray” button once you have done.

3. There are 5 types of control to the form you are assessing — Access, Create, Edit, Delete
and Print.

i. Access — Enable/disable the user to access to the form.
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ii. Create — Enable/disable the user to add a new record.

iii. Edit — Enable/disable the user to edit the existing record.

iv. Delete — Enable/disable the user to delete the record.

v. Print — Enable/disable the user to print the report/listing.

4. Click on the “Save” button once you have finished setup.
5. To delete the form name, use your cursor to point to the record and click on the
“Delete Detail” button.
6. If you want to delete the group policy, click on the “Delete” button.
7. Click on the “Exit"” button to exit.
5.2.3. Database Viewer

This option enables the user to access and edit the data files without system control. The
user is not advisable to edit the data files from here unless the user is familiar to the

system logic and database structure, otherwise, it will cause the system error.

** Database Yiewer

Database Table
Table Marme

Total Record(s)

File: Size

X

External Folder L

Li

arcust

arpso

AYTran

_|card

Field List

Field Marne

c:lubs softwarelubsposz003tdatalapvend. dbf

Figld Type

s

i | | o | |

Ordering List

Iorder Marme

W

[Juse Local Table

Expression L

Name

custnoi

CuU3Tho

name 2

addl

_|adaz

Frari

Ta

[ LR Rl L]

[ Yiew H Edit ” Exit ]

1. To view the record, select the table name from the list and click on the “View"” button.
2. To edit the record, select the table name from the list and click on the “Edit"” button.

3. Click on the “Exit"” button to exit.
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5.2.4. Database Clearance

This option enables the user to purge all the data files in the system. After purging, the
data files will not able to recover back.

* Natabase Clearance %]

Database Clearance
Clean up the database records. &

Plzase select the option below for the cleaning process

{*) Delete transaction records only

Al records in the transaction files will be erased but the maintenance files will
nat affecked.

") Delete all records in the database

Both maintenance and transaction file's recards will be erased.

e

1. Select the option to delete the records.

2. Click on the “Next” button and following the instruction until finished.

5.2.5. Recover Database

This option enables you to recover the Financial Period, Item Quantity and Transaction
data if there is data lost or inconsistency due to power failure or unforeseen reason.
% Hecover Databaze 3]
Option | Error Log
@ Before vou execute the Funckion, check the following steps:

- Close the opened Forms

- Inform users who are presently using the application to quit.

Recover the Following data:

[ ]Financial Period

|:| Ikem Quantity
[ ]Transaction

Cancel
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5.2.6. Year End Processing

This option enables the user to close the current year’s transactions and proceed to the
next fiscal year.

** Year End Processing

- All the transactions with the specified periods will be deleted.
- Please make sure wvou have backup a copy of the data before you run this process,

- Please inform users wha are presently using the application to guit,

5.2.7. Language Editor

The language editor is use to maintain the multi-languages library.

** | anguage Editor E|
English Chinese [GB2312] [
'
General Find Irnpart and Expart
Statement (English)
Statement (Other)
Language Chinese [GBZ31Z] V| Total Records I:l
[ Add " Edit “ Delete " Print ] l Exit I
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5.2.8. Font Editor

This option enables the user to reset or change the system’s font style and font size.

** Font Editor

% Label
Fonk Marme Tahoma | Sample
Font Size g

Text Box

Fonk Mame Courier HMNew | Sample
Fank Size 9

Margin z B

[ o ][ cort ]

1. Click on the button beside the font name to change the font style and font size.

2. Click on the “"OK" button to exit.

5.3. Index Database

This option enables the user to re-index all the database files in the system.

** Rpindex Database X

Reindex Database
Reinde:x the existing database. g
F—a

In network environment, make sure you are the only user to access
to this option

1. Click on the “"OK" button to start database indexing.

2. Click on the “Cancel” button to exit.
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5.4. Upgrade Database

This option enables the user to upgrade the database into a latest version.

** Upgrade Database X

Upgrade Database
Upgrade the exizting databaze stiucture, @
rFr—a

In network environment, make sure you are the only uzer to access
to this ophion

Q. Cancel

1. Click on the “"OK" button to start database indexing.

2. Click on the “Cancel” button to exit.

5.5. Backup and Restore

This option enables the user to backup and restore all the data files.

** Backup and Restore rz|
Backup and Restore ity
Backup and restore database, 1@

Please stop all operations in order to backup a complete set of the database.

Defaulk Directory |

[ include index files

Progress

[Cotor ] (ot ] [ |
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To Backup
1. Select the disk drive or directory that you want to save your backup files.

2. Specify the directory where the data files located into Default Directory.
3. Click on the “Backup” button to start backup.

To Restore
1. Select the disk drive or directory that your backup files located.

2. Specify the directory to restore the data files.

3. Click on the “Restore” button to start restore.

Import and Export

Import and Export enables you to transfer the existing data from one computer to another.

Maintenance Transaction Enguiry Reports IgMM Help  Exit

Setup 3

poi “t Of Sa I Administrative Tools 4

Index Database

Backup and Restore

Import and Export Irnpart Data

Export Data

Change Password

Select Printer. ..

5.6.1. Import Data

This option enables the user to import the Item, Category, Group, Member, Customer, Vendor
and Transaction data into database.

** |mport Data [X]

Iten
Cateqgory
Group
HMember
Customer
Vendor
Transaction
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1. Select the data you wish to import and specify the data folder.

2. Click on OK button to start the import.

5.6.2. Export Data

This option enables the user to export the Item, Category, Group, Member, Customer,
Vendor and Transaction data from database.

% Expork Data 3]

Category
Group
HMembher
Customer
Vendor
Transaction

| 0] | | Cancel

1. Select the type of information you wish to export.
2. Filter the criteria in the reference no. and date and specify the destination folder.

3. Click on OK button to start the export.

5.7. Change Password

This option enables the user to change the user password.

** Change Password [5__<|
% Uszer ID |
Password |

Mew Paszword |

] ‘ Cancel ‘

1. Key in the user id.
2. Key the existing password and the new password.

3. Click on “Exit” button to accept and exit.
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5.8. Select Printer

This option enables you select the printer you are using.

Printer

Printer

Harme: WWUBS-SERVYERNHP Laser)et 1100 [kM5]

Statuz: Feady
Type: HF Lazer)et 1100 [M5]

whhere:  LPTT:

Caomment:

] ] [ Cancel

1. Click on the arrow down button to select the printer you are using.

2. Click on “"OK" button to accept and exit.
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Chapter 6: HELP

This section allows the user to check the system’s version, product license information, the program
directory and file statistics.

6.1. About

This option enables the user to check the system’s version, product license information and the
program directory. Go to Help - About.

6.2. File Statistics
This option enables the user to choose the file statistics such as the file name, total fields, total

records, file size and last modified date.
Go to Help > File Statistics.
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